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Abstract 

The C099-F9P board enables customers to evaluate RTK operation with the ZED-F9P high precision 
GNSS receiver. The board provides short-range wireless connection via Bluetooth® or Wi-Fi for 
receiving correction data and logging via wireless connectivity. 
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1 Introduction 
The C099-F9P board is a convenient tool that allows customers to become familiar with the u-blox 
ZED-F9P high precision GNSS module. The board provides facilities for evaluating the product and 
demonstrating its key features. The C099-F9P application board offers: 

 
• A ZED-F9P module for use as an RTK rover or reference station 
• An ODIN-W2 short-range module to provide untethered operation using Bluetooth and Wi-Fi 
• Power supply options comprising a USB connection, Li-Po (lithium polymer) cell with recharging 

ability, and 6-17 V DC input1 
• Small, lightweight board (110 x 55 mm) with Arduino R3/Uno shield connections for host 

expansion 
 

The C099-F9P board allows for two alternative firmware versions to be used with the ODIN-W2 
short-range module. These are: 

1. C099-F9P Mbed3 application firmware. This is the default ODIN-W2 firmware pre-loaded to C099-
F9P boards. 

2. ODIN-W2 u-connectXpress software. This is the standard firmware for ODIN-W2 modules. See 
section 7.2 on how to change to this firmware. 

☞ This User guide describes how to use the C099-F9P board with the ODIN-W2 u-connectXpress 
software. 

This User guide describes the following use cases: 

1. Base and rover operation via serial connectivity 
2. Base and rover operation via Wi-Fi (with ODIN-W2 u-connectXpress software) 
3. Rover operation via Bluetooth Classic (with ODIN-W2 u-connectXpress software) 

 

This user guide is split into several sections: 

• Section 2: C099-F9P quick start provides information on how to get C099-F9P up and running 
straight out of the box. 

• Section 3: C099-F9P description identifies the board’s facilities.  
• Section 4: Using the C099-F9P provides a comprehensive guide for in-depth usage. 
• Section 5: Rover operation using NTRIP shows different ways of connecting to an NTRIP service. 
• Section 6: Reference station and rover pairing shows pairing using two C099-F9P boards as a 

reference/rover pair. 
• Section 7: Firmware update provides instructions for updating the firmware of the ZED-F9P high 

precision GNSS module as well as the ODIN-W2 short-range module. 
• Section 8: Arduino header connections provides mechanical specifications for Arduino R3/Uno. 
• The sections in the Appendix provide the u-blox configuration files and give information on C099-

F9P antenna schematics, and C099-F9P mechanical board dimensions and schematics. 
  

                                                                 
1 The C099-F9P kit does not contain a battery or an external power adapter. 
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1.1 Package contents 
The delivered package contains: 

• C099-F9P board (rev. E)  
• u-blox ANN-MB-00 multi-band GNSS antenna and ground plane 
• Wi-Fi/Bluetooth antenna 
• USB interconnect cable 
• Quick start guide 
• USB-to-DC plug adapter cable 

 
Figure 1: C099-F9P board and antennas 

1.2 Additional sources of information 
Prior to using the board, it is useful to download the appropriate evaluation software and keep handy 
the documents listed in the Related documents section. 
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2 C099-F9P quick start 
This section provides some quick steps to enable ZED-F9P operation before exploring the more 
complex configurations described later.  

 

Figure 2: Basic C099-F9P overview with details needed for quick start 

2.1 Starting up 
• Connect the supplied multi-band GNSS antenna to the ZED-RF SMA connector. Ensure good 

signal reception. 
• Connect the USB to a Windows PC; this will power the board. The FTDI and USB drivers will be 

installed automatically2 from Windows Update when the user connects the board for the first 
time. Note that the board has current limitation functionality on USB. Thus, ZED-F9P and ODIN-
W2 modules will power up after the drivers have been successfully installed and the USB 
enumeration is completed. 

• Start u-center and connect to the COM port identified as C099 application board, ZED-F9P using 
Device Manager. Set the baud rate to 460800 baud. See section 4.3.1 for detailed instructions. 

• The time pulse LED on the C099-F9P board will blink in blue once the ZED-F9P has obtained valid 
time information. Figure 3 below shows a typical u-center view with active satellite signal levels. 

To operate the ZED-F9P in RTK mode, the GNSS antenna must be placed in an open environment and 
the unit must be connected to an RTK correction service. Where available, the evaluation kit comes 
with a free trial of the SmartNet correction service. Consult the leaflet included with the kit for 
information on how to register for the service and how to obtain mount point and user connection 
details before moving to the next steps. 

RTK corrections can be applied using a u-center built-in NTRIP client. To use the C099-F9P board with 
a correction service follow these next steps: 

• In u-center, click on the Receiver menu item. 
• Select NTRIP Client… 
• Fill in the settings for the NTRIP caster, username and password. 
• Click Update source table and select the recommended NTRIP mount point. 
• Click OK to close the dialog and connect to the service. 
• In the Data View of u-center, the Fix Mode should change from 3D to 3D/DGNSS when RTCM 

corrections are received. The RTK LED will blink in green. 

                                                                 
2 For manual driver installation, check GNSS Sensor and VCP Device Driver User guide in Related documents  

USB port ZED-F9P LEDs ZED-F9P module ZED-RF connector 
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• Eventually, the status will change to 3D/DGNSS/FIXED and the RTK LED will show a steady green 
light. 

 

 
Figure 3: u-center showing a view of the ZED-F9P default operation 
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3 C099-F9P description 

3.1 Component overview 
The C099-F9P houses the ZED-F9P RTK high precision positioning module and an ODIN-W2 module 
for wireless short-range communications. An FTDI component provides dedicated COM port 
connections with the ZED-F9P and ODIN-W2 via a USB connector.  

The board can be powered by USB, a DC supply socket, or by a Li-Po (lithium polymer) battery. The 
board has been designed using an Arduino form factor with the modules’ serial ports routed to the 
shield headers. Note that a secondary USB power source is available via the USB-to-DC plug adapter 
cable. 

The block diagram in Figure 4 shows the logical signal flow between the individual parts. 

 

 
Figure 4: C099-F9P block diagram 

3.2 Component identification 
The following images show the position of major parts and user interfaces. 

• Main components – Figure 5 
• Switches and LEDs – Figure 6 

Their functions are described later on in this section. 
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Figure 5: Main components and USB ports 

 
 

J9 

J8 

J3 

J2 

ZED-F9P multi band GNSS RTK module 

ODIN-W2 multi-radio module 

USB (ZED-F9P USB and UART, 
ODIN-W2 UART ports) 

GNSS antenna connector 

 

 J2, J3, J8, J9 
Arduino Uno connectors 

DC power jack 

Battery connector  

Wi-Fi/BT antenna connector 
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Figure 6: Switches and LEDs 

☞ The MicroSD card slot is not used in this version of the board. The ODIN-W2 Switch 0 interrupt is 
not required for normal customer use. 

3.2.1 ZED-F9P status LEDs 

The board provides three LEDs to show the ZED-F9P status. The location of the LEDs is shown in 
Figure 7 below. 

The RTK status LED provides an indication of the state of the ZED-F9P module RTK-STAT pin.  

• At start-up the LED is off. 
• When a valid stream of RTCM messages is being received and utilized, but no RTK fixed mode has 

been achieved, the yellow LED flashes. 
• When in RTK fixed mode, the yellow LED is turned on. 

The blue time pulse LED will flash at the default 1 Hz rate when the time solution is valid.  

If activated, the Geofence status LED indicates the current Geofence status, i.e. in or outside a 
designated area. 

See the ZED-F9P Interface description [1] for help with configuring the time pulse output or activating 
the Geofence pin. 

GNSS LEDs: TP, RTK, Geofence 

Battery charger LED 

ODIN-W2 activity LED 

ODIN-W2 safeboot pins  

ODIN-W2 switch 0 interrupt button 
 

ZED-F9P safeboot button 

ZED-F9P and ODIN-W2 reset button 
 

Battery incorrect polarity indicator 
LED 



 C099-F9P - User guide 

UBX-18055649 - R09 C099-F9P description Page 12 of 49 
C1-Public   

 

 
Figure 7: ZED-F9P LEDs 

3.2.2 ODIN-W2 activity LED 

The ODIN-W2 module uses a multi-colored LED to show particular activity status. This is positioned 
adjacent to the ZED-F9P reset switch and shown below in Figure 8. The activity status is summarized 
in Table 1 below. 

Mode Status LED color 

Data mode, EDM IDLE  Green 

Command mode  IDLE  Orange  

Data mode, Command mode, EDM  CONNECTING Purple 

Data mode, Command mode, EDM  CONNECTED3  Blue 

Table 1: ODIN-W2 u-connectXpress software LED activity states and colors 

 

 
Figure 8: ODIN-W2 Activity LED position on C099-F9P board 

                                                                 
3 On data activity, the active LED flashes. 

ODIN-W2 activity LED 

ZED-F9P Geofence status LED 

ZED-F9P RTK status LED 

ZED-F9P time pulse LED 
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4  Using the C099-F9P 
The C099-F9P is shipped with the latest HPG firmware for the ZED-F9P GNSS module. Information 
on updating either module’s firmware is provided in section 7 Firmware update, if required. 

4.1 Powering the board 
The board can be powered from a variety of sources: 

• The USB connection 
• A 3.7 V Li-Po Battery via a JST connector 
• An external 6-12 V DC source via a 2.1mm connector; center pin V+. Also, the included USB-to-DC 

plug adapter cable can be used to provide an additional USB power source. 
 

 
Figure 9: Power connections 

 

 
Figure 10: Typical single-cell 3.7 V Li-Po battery with JST connector 

⚠ Follow all published safety advice for using bare cell Li-Po batteries while charging and protecting 
them from mechanical damage. Fire risk can occur if the advice is not followed. 

⚠ Ensure correct polarity on the JST battery connector. In case of an incorrect polarity, the incorrect 
polarity LED will be on. Due to the polarity protection feature, the supply rails will not be powered.  

All supply connections are fed via a Schottky diode to the main supply bus to allow multiple sources 
to be connected in parallel. The Li-Po battery will be charged from either the DC power source or the 

DC power jack 

Li-Po battery connector 

USB 
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USB power source. The charging status is indicated by a red LED which is on during charging and 
turned off when fully charged.  

When less than 500 mA is available from the USB host, ensure sufficient extra supply via the DC power 
jack. Note that due to the higher current consumption caused by the battery charging it is not 
recommended to charge the battery via USB only. 

☞ Supplying through the USB port requires the power source (USB host) to support the USB 
enumeration process. If the power source is not capable of enumeration, you may use the provided 
USB-to-DC adapter cable and connect it to the DC plug. There is no current limitation for the DC 
supply. 

 
Figure 11: Battery charge status LED 

4.1.1 Non-wireless operation 

For use-case scenarios where non-wireless data link is needed the ODIN-W2 can be disabled. In order 
to disable the ODIN-W2, connect the safeboot jumper which forces the ODIN-W2 into safeboot mode 
during the device start-up. See Figure 6 to locate the safeboot pins. 

On average, the ODIN-W2 consumes less current when started in the safeboot mode. In addition, the 
safeboot mode ensures that no intentional radiation originates from the 2.4 GHz antenna connector.  

4.2 GNSS RF input 
The C099-F9P board should be used with the antenna supplied with the kit. If another active antenna 
is used, be aware that the RF input has a bias output designed to supply 3.3 V DC with a 70 mA 
maximum current load. A DC block is advisable if the board is connected to a signal distribution 
scheme or GNSS simulator to prevent any potential shorting of the antenna bias. 

 
Figure 12: GNSS antenna connector 

When using the supplied antenna it is advisable to use the ground plane provided. Otherwise ensure 
that there is an adequate ground plane, e.g. by mounting in the center of a metallic car roof. 

Red battery charge LED 

SMA GNSS antenna connector 

Orange battery incorrect 
polarity indicator LED 
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Figure 13: The supplied GNSS multi-band antenna 

4.3 User interfaces 
The C099-F9P has a number of fixed connection options besides the wireless modes. There is also an 
additional Arduino R3 / Uno interface for external host connection. 

The USB connector on the board provides connection via an on-board hub providing: 

• An FTDI USB bridge to ZED-F9P UART1 and ODIN-W2 UART COM ports. 
• Dedicated connection to the ZED-F9P USB port. 

4.3.1 FTDI USB bridge 

When the USB cable from the user’s PC is connected, a driver will load and set up two virtual serial 
ports, as shown below in Figure 14.  Additionally, a further serial VCP will be created to provide a direct 
connection with the ZED-F9P USB port. 

☞ Ensure that the PC is connected to the internet to load the drivers from Windows Update. 

The first of these is connected to the ZED-F9P serial port and should be selected with u-center. The 
second serial device is for the ODIN-W2 module when using s-center. In Figure 14 the ODIN-W2 
connection is the first port (COM 62) and the ZED-F9P connection is the second port (COM 64). Port 
numbering can be different between individual PCs, but the same arrangement applies. 

 
Figure 14: Windows Device Manager COM port view 

In addition, a third VCP will be created corresponding to the ZED-F9P USB port. Windows 10 users will 
see a new VCP device in the Device Manager window as it will load an in-built driver. With older 
Windows installations, a driver will be loaded via Windows Update. In this case the device will be 
identified as a u-blox GNSS device in the Device Manager window. 

Open u-center, select the ZED-F9P serial port, and set the baud rate to 460800 to match the ZED-
F9P default UART setting. Once connected, u-center shows typical received signal levels from 
multiple GNSS bands, see Figure 15 below. 

ZED-F9P and ODIN-W2 
COM ports installed 
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Figure 15: u-center view with ZED-F9P connected 

Additional UBX protocol messages can be enabled to view additional information in u-center. For 
example, the following are typical messages the user can poll or enable for periodic update. 

• UBX-NAV-HPPOSLLH 
• UBX-NAV-RELPOSNED 
• UBX-NAV-SIG 
• UBX-NAV-PVT 
• UBX-NAV-STATUS 
• UBX-NAV-SVIN 

For help with the Message view, see u-center User guide [3]. 

4.3.2 Bluetooth serial COM port connection 

Before using Bluetooth ensure that the supplied Wi-Fi/Bluetooth antenna has been connected to the 
SMA connector “ODIN-RF” to ensure correct operation of the wireless functions. 

• Create the u-blox configuration file for the rover BT link. Use the “u-blox ODIN-W2 BT Rover.txt” 
file listed in Appendix D. You can also download the file from Github: https://github.com/u-
blox/ublox-C099_F9P-uCS/tree/master/odin-w2  

• For information on how to upload configuration file using s-center, see section 6.1.1 Configuring 
a C099-F9P rover for Wi-Fi operation.  

On the PC, go to the Bluetooth setup and in the Windows Add a device window, add the ODIN-W2 
module as a device, identified as “ODIN-W2-XXXX”, by selecting ODIN-W2 and clicking Next. See 
Figure 16 and Figure 17 below. 

https://github.com/u-blox/ublox-C099_F9P-uCS/tree/master/odin-w2
https://github.com/u-blox/ublox-C099_F9P-uCS/tree/master/odin-w2
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Figure 16: Windows 7 Add a device window shows ODIN-W2 

 
Figure 17: Click on the ODIN-W2 and select Next 

You can locate the device by examining the Bluetooth connections under the Ports tab in the Windows 
Device Manager. Search for a “Standard Serial over Bluetooth link” - usually the first one on the list. 
Use this device for connecting the ZED-F9P to u-center. 

 
Figure 18: Installed Bluetooth SPP port 

The ODIN-W2 module communicates with the ZED-F9P via a serial port which is shared with the FTDI 
USB/COM port via multiplexors. Once Bluetooth communication is established with the ODIN-W2, a 
jumper connection should be made at position “3OE” to connect the serial ports of the ZED-F9P and 
ODIN-W2 together. See Figure 19 below. 
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Figure 19: C099-F9P rover jumper position 

 
For information, Figure 20 below shows the C099-F9P logical connections for serial interfaces with 
the “OE3” jumper set as required to connect the ODIN-W2 and ZED-F9P serial ports. 
 

 
Figure 20: Schematic showing serial interface connection with jumper OE3 setting  

Jumper position “3OE” 
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4.3.2.1 Windows OS issues with Bluetooth SPP 

There are some known issues with the Windows Bluetooth Serial Port Profile (SPP) implementation 
for Windows 7-10. Symptoms include the Bluetooth Virtual COM port not installing or applications 
not connecting to the Bluetooth Virtual COM port. In other cases Windows might crash or become un-
responsive. This is not related to the ODIN-W2 Bluetooth implementation that uses the Bluetooth 
standard SPP.  

 

Figure 21: ASUS USB-BT400 

A known industry fix is to not use the Windows Bluetooth stack and PC Bluetooth hardware. This is 
done by using a USB Bluetooth adapter that uses its own Bluetooth stack. A device that is known to 
work is the ASUS USB-BT400 (USB 2.0). Once installed use the Bluetooth Virtual COM port assigned 
to this device and not the built-in Bluetooth. 
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5 Rover operation using NTRIP 
This section shows how the ZED-F9P is used as a rover using correction information provided over the 
internet using NTRIP. This is usually provided by a host from a single reference station or as a Network 
RTK Virtual Reference Service (VRS).  

A suitable host is a PC with internet access. A host runs an NTRIP client and streams RTCM 
corrections to the C099-F9P through a UART or Bluetooth connection. Messages transmitted 
through a Bluetooth or Wi-Fi link are forwarded to I2C bus and vice versa.  The user is advised to enable 
desired messages in both UART and I2C interfaces in ZED-F9P. 

5.1 PC hosting via u-center 
The u-center application includes an NTRIP client for PC hosting. The u-center User guide [3] provides 
help when setting NTRIP service connections. Users can connect via Bluetooth for wireless operation 
or directly via a serial COM port. Once the service is active, RTCM corrections are sent over the 
connection and data can be logged as usual with u-center. 

The u-center User guide [3] provides more information concerning NTRIP connections. Enter the 
required connection settings using the client setting window show below. 

 
Figure 22: u-center NTRIP client view 

Ensure that the NTRIP client connection icon is green. This indicates a successful NTRIP connection 
and that RTCM data is transferred to the C099-F9P. 

 
Figure 23: u-center NTRIP client communication indicator 
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Confirm that the rover has obtained RTK fixed mode in the u-center Data view: 

 
Figure 24: u-center Data view RTK FIXED indication 

 

5.2 Mobile hosting 
A portable rover option is offered by an Android application which utilizes Bluetooth connection to a 
single C099-F9P. An example application is provided by Lefebure and it is available from Google Play 
Store: https://play.google.com/store/apps/details?id=com.lefebure.ntripclient. 

 
Figure 25: Lefebure Android NTRIP client 

 

5.3 Pairing the host with the C099-F9P 
For both options the user needs to pair the host (PC or mobile) with the C099-F9P ODIN-W2 wireless 
module. 

Once paired the user can then attach the host application to the C099-F9P to send and receive data. 

☞ See Section 4.3.2 Bluetooth serial COM port connection for pairing information. 

 

https://play.google.com/store/apps/details?id=com.lefebure.ntripclient
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6 Reference station and rover pairing 
This section is provided for users with two C099-F9P boards and provides configuration information 
when setting up a C099-F9P as a reference station to provide local RTCM corrections for a C099-F9P 
rover.  This connection uses Wi-Fi connectivity to maximize range for untethered operation. 

6.1 Wi-Fi connection between two C099-F9P boards 
This set-up relies on establishing a peer-to-peer Wi-Fi connection between two C099-F9P boards for 
short base-line applications, e.g. drones and the like. 

Separate ODIN-W2 configuration files are required to enable the reference station and rover C099-
F9P boards to operate as an Access Point and client respectively. Ensure the ODIN-W2 on the rover 
and reference station runs the u-blox u-connectXpress software. 

Prior to use, the reference station C099-F9P needs RTCM3 output messages enabled and its position 
surveyed-in. When the device is surveyed-in, it will enable output of the RTCM3 1005 message to 
enable the rover to begin RTK operation.  Consult the Integration manual [2] for information relating 
to reference station operation for more information. 

In this example the C099-F9P reference station sends corrections to a C099-F9P rover and the rover 
transmits NMEA and UBX messages back to the base. The rover operation can be viewed remotely 
with u-center connected to the reference station’s ODIN-W2 COM port. 
 

                                                                                                  
 
          
 

Figure 26: Reference and rover C099-F9P set up 

 The sub-sections below describe the steps required to configure the boards for Wi-Fi operation plus 
the settings needed for rover and base operation.  

6.1.1 Configuring a C099-F9P rover for Wi-Fi operation 

The following steps provide guidance on configuring the C099-F9P ODIN-W2 Wi-Fi for rover operation: 

☞ Disconnect any UART multiplexor jumper connections before proceeding. 

• Connect the rover unit via USB to a PC.  
• Install the u-blox s-center evaluation application. 
• Open s-center which will show the following view: 

Bidirectional peer-to-peer Wi-Fi link 

Rover     Base 
USB #1 ODIN-W2 port to u-center 
for rover data 
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Figure 27: s-center connection setting window 

• Select the COM port installed for the ODIN-W2.  
• Set the baud rate to 460800 baud. 
• Ensure hardware flow control is not enabled. 
• Click on the “FTDI USB Latency Timer” Update button.  
• Click Open Port. 
• If the C099-F9P is powered, the ODIN-W2 responds with AT commands. 

 
Figure 28: s-center connected to ODIN-W2 
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It is important to do a factory reset on the ODIN-W2 before downloading a new configuration file. Click 
the Factory button in the same window to perform a factory reset. 

 
Figure 29: s-center factory reset button 

After factory reset, the device will be set with a baud rate of 115200 baud with hardware flow control 
enabled. You must change this to no hardware flow control: 

• First set s-center to 115200 baud and no flow control.  
• Open the COM port. 
• Select EVK-ODIN-W2 via ST-LINK button as shown below to disable flow control. 

 
Figure 30: Resetting ODIN-W2 to no flow control 

Click the AT Mode button to ensure it is responding correctly. You will see it respond with AT 
commands if communication is OK. 

 

 
Figure 31: Clicking AT Mode button 

 

Download the u-blox configuration file for the rover Wi-Fi link. Use the “Rover ODIN-W2 Access Point 
UDP Server.txt” file listed in Appendix D. You can also download the file from Github: 
https://github.com/u-blox/ublox-C099_F9P-uCS/tree/master/odin-w2  

Select File > Download Configuration. 

https://github.com/u-blox/ublox-C099_F9P-uCS/tree/master/odin-w2
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Figure 32: Selecting File > Download Configuration 

 

Select the “Rover ODIN-W2 Access Point UDP Server.txt” file and click Open. 

 
Figure 33: Selecting file “Rover ODIN-W2 Access Point UDP Server.txt” 

Disconnect s-center from the ODIN-W2 port and toggle the C099-F9P off and on again to ensure it 
will be using the new configurations as default. 

Position a jumper as shown in Figure 20 to connect the ZED-F9P and ODIN UARTs. This will enable 
correction traffic from the rover and provide a return path for messages from the rover. 

Connect the GNSS antenna, ensure use with the supplied ground plane and place in good GNSS 
visibility conditions. 

In order to prevent the ODIN-W2 from mistranslating NMEA and UBX streams, it is advisable to 
reprogram the factory default escape sequence ‘+++’ as described in the AT command manual [5]. 

6.1.2 Configuring a C099-F9P reference station (Base) for Wi-Fi operation 

The following steps describe setting up the C099-F9P ODIN-W2 Wi-Fi for reference station operation.  

☞ Disconnect any jumper connections before proceeding. 

Follow the same process for configuration described above in section 6.1.1 Configuring a C099-F9P 
rover for Wi-Fi operation except load the reference station configuration file “Base ODIN-W2 Station 
UDP client.txt” instead - see Appendix E for the file listing. 

After this the C099-F9P reference station will require setting up as shown below to enable sending 
correction data to the rover. 
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6.1.3 ZED-F9P reference station (Base) and rover configuration 

With the latest version u-center, connect to the C099-F9P using the dedicated ZED-F9P USB 
connection. 

See section “Required configuration of the base and rover” in the ZED-F9P Integration Manual [2] for 
details on configuring the required RTCM3 messages and setting the ZED-F9P as a reference station. 
We provide easy-to-use configuration files to download, as detailed in the next section. 

☞ Ensure all RTCM messages are set to transmit from UART1 and the baud rate is set to 460800, 
otherwise the ZED-F9P and ODIN-W2 cannot communicate. Wrong settings can occur if the ZED-
F9P firmware is updated or the ZED-F9P UART1 is set to its default state.   

☞ Ensure that the UART1 port protocols are set to “None” for input and “RTCM3” for output to 
prevent input of the received rover messages.  

☞ Place a jumper at position “OE3” as shown in Figure 19, this will connect the ODIN-W2 and ZED-
F9P UARTs to provide transmission of RTCM messages to the rover. 

6.1.3.1 Downloading Base ZED-F9P configuration file 

Download the configuration files from: https://github.com/u-blox/ublox-C099_F9P-uCS 

Or save the contents of Appendix F to a .txt file. Open u-center View > Generation 9 Configuration 
View: 

 

 

Figure 34: u-center View > Generation 9 Configuration View  

Select Advanced Configuration: 

 

 

Figure 35: u-center View > Generation 9 Configuration View > Advanced Configuration 

https://github.com/u-blox/ublox-C099_F9P-uCS
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Important next step – return receiver to defaults by selecting the icon in the Action toolbar (see 
number 1 in Figure 36): 

 

Figure 36: Return receiver to defaults and select 38400 baud 

 

 

Select Load to load the “F9P Base config C99.txt” file and Send to send the configuration: 

 

 

Figure 37: Load “F9P Base config C99.txt” file and click Send  

 

Keep the USB connected to the PC, however disconnect u-center from the ZED-F9P USB port and 
connect to the ODIN-W2 USB Virtual Com Port. This will allow viewing and logging of the rover C099-
F9P message data via the return Wi-Fi link. 

Connect the GNSS antenna, ensuring use with the supplied ground plane and place in good GNSS 
visibility conditions. 

Now load the “F9P Base Survey in start.txt” file in the same way, except do not return the receiver to 
default settings, as we have a working configuration. It should carry out the Survey-In process and 
then output all the required RTCM messages. 

6.1.3.2 Downloading Rover ZED-F9P configuration file 

Connect the Rover ZED-F9P via the dedicated USB connection.  

Load and Send the “F9P Rover config C99.txt” file as shown in the previous section. Both units will 
now be ready to operate. You would have previously downloaded it from the u-blox GITHUB repository, 
or copied the contents of Appendix F to a .txt file. 
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A Wi-Fi connection is established between reference and rover boards when the rover C099-F9P is 
powered up. The ODIN-W2 activity LED is set blue when the base and rover have connected and 
flashes when data transfer is occurring. Look for acquisition activity shown in u-center to confirm the 
rover is operating correctly.  

⚠ Ensure that any rover ZED-F9P output messages and configurations required are set before 
connecting the reference as this can only be done via the dedicated ZED-F9P USB connection. 
Ensure that the configuration is saved to flash to avoid reverting to a default operation after power 
cycling. 

u-center will now show the rover GNSS information via the reference C099-F9P ODIN-W2 connection: 

 
Figure 38: u-center satellite signal view 

Check that the rover has obtained a RTK Fixed mode in u-center Data view: 

 

Figure 39: u-center Data view RTK FIXED indication 
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7 Firmware update 
This section shows how to update the GNSS and Wi-Fi/Bluetooth modules’ firmware if required. 

The board is delivered with the latest versions of firmware running on the ZED-F9P and ODIN-W2 
modules. However, newer versions may become available during the lifetime of the product.  

7.1 ZED-F9P firmware update 
This section shows how to update the firmware and re-enable the configuration settings required for 
the C099-F9P. The user has two possible serial communication channels to update ZED-F9P: UART1 
and USB2.0 ports.  

To update the ZED-F9P, connect to u-center via USB to the COM port identified as the ZED-F9P and 
poll MON-VER to view the installed firmware: see Figure 14 for the Device Manager COM port view. 
The shipped units will have HPG 1.12 firmware or newer. To download a new firmware follow the 
sequence detailed below. 

 
Figure 40: MON-VER poll response 

To begin updating the firmware, select Tools > Firmware Update… 

 
Figure 41: Selecting u-center Firmware Update mode 

 

The following Firmware image update window will appear: 
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Figure 42: Selecting u-center Firmware image folder 

At the top is the Firmware image file selection window. Click on the button to the right of the window. 
This allows you to select the folder and file. Select the new firmware image bin file.  

Set the Enter safeboot before update and Send training sequence options. Set the Use this baudrate 
for update option and select e.g. 460800 from the pull-down list. This is shown in Figure 43 below. 

 
Figure 43: Setting the required baud rate, safeboot and training sequence options 

Then click the GO button at the bottom left corner of the window to begin the download. 

 
Figure 44: Click GO for firmware update 

The firmware update progress indication is shown adjacent to the input window. 
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Figure 45: Programming progress and completion message 

When programming is complete, the module will start up in a default configuration in which the ZED-
F9P serial port is set to 38400 baud. This requires changing to 460800 baud to provide sufficient data 
bandwidth and work correctly with the ODIN-W2 module. In order to make the baud rate change 
persistent follow the instructions in the figure below. 

 

Figure 46: Setting ZED-F9P UART1 back to 460800 baud and saving it to flash memory 

 

7.2 ODIN-W2 firmware update  
Users have a choice of running two distinct firmware variants in ODIN-W2. By factory default the 
ODIN-W2 on a C099-F9P runs a dedicated Mbed application firmware. 
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7.2.1 Mbed OS 3 application firmware 

The latest released binary is available via the u-blox git-hub repository: 

https://github.com/u-blox/ublox-C099_F9P-mbed-3 

Firmware update on ODIN-W2 is possible by the following tool set: 

• Through ODIN-W2 UART1 by using stm32flash.exe 
 
It is recommended to download the stm32flash.exe command line tool from STM website or from 
Sourceforge:  https://sourceforge.net/projects/stm32flash/  
 
Place the downloaded stm32flash executable in the same folder with the FW binary and check for a 
correct ODIN-W2 COM port number in the Device Manager (Windows users). 
 
To ensure no settings persist over the firmware versions, it is recommended to revert to factory 
default before uploading a new firmware. 
 
Prior to firmware upload, the ODIN-W2 must be started in safeboot mode. Proceed by placing a 
safeboot jumper and reboot C099-F9P. Location of the safeboot pin header and the reset button is 
depicted in Figure 6. To confirm the ODIN-W2 started in safeboot mode the ODIN-W2 activity LED 
remains off.  Use the following command structure in power shell or command prompt to start the 
FW upload: 

.\stm32flash.exe -b 115200 -w <c099mbed3.bin> -S 0x8000000 COM<port number> 

To confirm a successful FW upload remove the safeboot jumper and restart the device. The ODIN-
W2 activity LED lights up. 

 
Figure 47: Power shell capture of FW upload 

7.2.2 u-connectXpress software 

To utilize the standard ODIN-W2 connectivity stack, a firmware update is required. 

The latest u-blox u-connectXpress software and related documentation is available via u-blox.com: 
https://www.u-blox.com/en/product/odin-w2-series  

It is recommended to download the stm32flash.exe command line tool from STM website or from 
Sourceforge: https://sourceforge.net/projects/stm32flash/   

The software upload procedure consists of two consecutive phases. First, you must upload a 
bootloader, but prior to the bootloader upload, you must restart the ODIN-W2 in safe boot mode.  

https://github.com/u-blox/ublox-C099_F9P-mbed-3
https://sourceforge.net/projects/stm32flash/
https://www.u-blox.com/en/product/odin-w2-series
https://sourceforge.net/projects/stm32flash/
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Proceed by placing a safe boot jumper and reboot the C099-F9P. The location of the safe boot pin 
header and the reset button is depicted in Figure 6: Switches and LEDs.  

Continue with the bootloader upload: 

.\stm32flash.exe -b 115200 -w <ODIN-W2-BOOT.bin> -S 0x8000000 COM<port number> 
 

The actual connectivity software shall be uploaded while the ODIN-W2 is still in safe boot mode. 

Ensure correct memory indexing by incrementing the memory argument as shown below: 

.\stm32flash.exe -b 115200 -w <ODIN-W26X-SW.bin> -S 0x8010000 COM<port number> 

 
Figure 48: Power shell capture of bootloader upload 

 

Figure 49: Power shell capture of connectivity software upload 

  

Once the connectivity software is uploaded successfully, the ODIN-W2 will be set with a baud rate of 
115200 baud with hardware flow control enabled. You must change this to no hardware flow control 
and set the ODIN-W2 UART baud rate to 460800 to ensure sufficient link bandwidth.  

To proceed, restart the ODIN-W2 in a normal boot mode by removing the safeboot jumper and 
pressing the RESET button.   

• Set s-center to 115200 baud and no flow control.  
• Open the COM port. 
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Select EVK-ODIN-W2 via ST-LINK button to disable flow control as shown in Figure 30. 

Navigate to “User Defines” AT command tab, as shown in Figure 50.  

 

Figure 50: Set baud rate 

Execute the following command set sequentially: 

• AT+UMRS=460800,2,8,1,1,0 
• AT&W 
• AT+CPWROFF 

Finally, adjust s-center baud rate to match 460800 by closing and opening the UART port. 

Click the AT Mode button to ensure it is responding correctly. You will see it respond with AT 
commands if communication is OK. 

 
Figure 51: Clicking AT Mode button 
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Download a u-blox configuration file for the ODIN-W2 module. The “u-blox ODIN-W2 BT Rover.txt” file 
is the default configuration file shipped with the C099-F9P. See Appendix C for configuration file 
resources.  

 
Figure 52: Selecting File > Download Configuration 

 

 
Figure 53: Selecting “u-blox ODIN-W2 BT Rover.txt” file 

Select the file and click Open. It will download the file and write it to flash. 

☞ The ODIN-W2 UART will now be set to 460800 baud in Data default mode. It will be ready for use 
again.  

Disconnect s-center from the ODIN-W2 port and power the C099-F9P off and on to ensure it will be 
using the new configurations as default. 

Position a jumper at “OE3” for Bluetooth operation. 

The rover is now ready to connect to PC or Mobile via Bluetooth SPP. 

The board is now ready to use for the wireless connection examples described in the earlier sections. 

When untethered operation is not required, the ZED-F9P dedicated USB connection on the C099-F9P 
can be used for supplying corrections and monitoring or logging purposes with u-center.  
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8 Arduino header connections 
The board size and four connectors comply with the Arduino R3/Uno mechanical specification. The 
functions of each I/O align as much as possible to the Arduino-specified functions. Check the pin 
functions before using with an Arduino R3/Uno; see Figure 55 below. All the pin functions besides 
power are 3.3 V compliant.  

   
Figure 54: C099-F9P Arduino connectors 

 

 
Figure 55 C099-F9P Arduino R3 connections 

J9, Arduino D 

J8, Arduino C 

J3, Arduino B 

J2, Arduino A 
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Appendix  

A Glossary 
Abbreviation Definition 

FW Firmware 

Li-Po Lithium polymer 

NTRIP Networked transport of RTCM via internet protocol 

RTK Real time kinematic 

UART Universal asynchronous receiver transmitter 

USB Universal serial bus 

UTC Coordinated universal time 

VCP Virtual COM port 

Table 2: Explanation of the abbreviations and terms used 

B Resources 
Applicable configuration files are available in u-blox Github:  

https://github.com/u-blox/ublox-C099_F9P-uCS 

C u-blox ODIN-W2 BT Rover.txt  
Copy all the text below this line into a text file named “u-blox ODIN-W2 BT Rover.txt”.  

AT+UBTLN="ODIN-W2-xxxx" 
AT+UBTLC=000000 
AT+UBTCM=2 
AT+UBTDM=3 
AT+UBTPM=2 
AT+UBTMSP=1 
AT+UBTLE=0 
AT+UBTSM=1 
AT+UNHN="ODIN-W2-200036001551373333393539" 
AT+UDDRP=0,"",0 
AT+UDDRP=1,"",0 
AT+UDDRP=2,"",0 
AT+UDDRP=3,"",0 
AT+UDDRP=4,"",0 
AT+UDDRP=5,"",0 
AT+UDDRP=6,"",0 
AT+UWSCA=0,4 
AT+UWSC=0,0,0 
AT+UWAPC=0,4 
AT+UWAPC=0,0,0 
AT+UWAPC=0,2,"" 
AT+UWAPC=0,4,1 
AT+UWAPC=0,5,2,2 
AT+UWAPC=0,100,1 
AT+UWAPC=0,106,1 
AT+UWSC=0,0,0 
ATS2=43 
ATS3=13 
ATS4=10 
ATS5=8 
AT+UDCFG=0,1 
AT&S1 
AT&D0 

https://github.com/u-blox/ublox-C099_F9P-uCS
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ATE1 
AT+UBTCFG=1,1 
AT+UBTCFG=2,1 
AT+UBTCFG=3,56602 
AT+UBTCFG=4,127 
AT+UBTCFG=5,0 
AT+UBTCFG=6,0 
AT+UBTCFG=7,2000 
AT+UBTCFG=8,0 
AT+UBTCFG=9,0 
AT+UBTLECFG=1,1600 
AT+UBTLECFG=2,2000 
AT+UBTLECFG=3,7 
AT+UBTLECFG=4,24 
AT+UBTLECFG=5,40 
AT+UBTLECFG=6,0 
AT+UBTLECFG=7,2000 
AT+UBTLECFG=8,5000 
AT+UBTLECFG=9,48 
AT+UBTLECFG=10,48 
AT+UBTLECFG=11,24 
AT+UBTLECFG=12,40 
AT+UBTLECFG=13,0 
AT+UBTLECFG=14,2000 
AT+UBTLECFG=15,5000 
AT+UBTLECFG=16,48 
AT+UBTLECFG=17,48 
AT+UBTLECFG=18,24 
AT+UBTLECFG=19,40 
AT+UBTLECFG=20,0 
AT+UBTLECFG=21,2000 
AT+UBTLECFG=22,5000 
AT+UBTLECFG=23,48 
AT+UBTLECFG=24,48 
AT+UBTLECFG=25,0 
AT+UMSM=1 
AT+UMRS=460800,2,8,1,1,1 
AT&W 
AT+CPWROFF 



  C099-F9P - User guide 

UBX-18055649 - R09 Appendix  Page 39 of 49 

D Rover ODIN-W2 Access Point UDP Server.txt  
Copy all the text below this line into a text file named “Rover ODIN-W2 Access Point UDP Server .txt”. 

AT+UWAPCA=0,4 
AT+UWAPC=0,0,1 
AT+UWAPC=0,2,UBXWifi 
AT+UWAPC=0,4,1 
AT+UWAPC=0,5,1,1 
AT+UWAPC=0,100,1 
AT+UWAPC=0,101,192.168.0.10 
AT+UWAPC=0,102,255.255.0.0 
AT+UWAPC=0,103,192.168.0.1 
AT+UWAPC=0,104,0.0.0.0 
AT+UWAPC=0,105,0.0.0.0 
AT+UWAPC=0,106,1 
AT+UWAPCA=0,1 
AT+UWAPCA=0,3 
AT+UWCFG=1,0  
AT+UDSC=1,2,5003,1 
AT+UMSM=1 
AT+UMRS=460800,2,8,1,1,0  
AT&D0 
AT&W 
AT+CPWROFF 

E Reference station ODIN-W2 UDP client.txt  
Copy all the text below this line into a text file named “Base ODIN-W2 Station UDP client.txt”. 

AT+UWSCA=0,4 
AT+UWSC=0,0,1 
AT+UWSC=0,2,"UBXWifi" 
AT+UWSC=0,5,1 
AT+UWSC=0,100,2 
AT+UWSCA=0,1 
AT+UWSCA=0,3 
AT+UWCFG=1,0  
AT+UMSM=1 
AT+UDDRP=0,"udp://192.168.0.10:5003",2 
AT+UMRS=460800,2,8,1,1,0  
AT&D0 
AT&W 
AT+CPWROFF 
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F  F9P Base config C99.txt 
Copy all the text below this line into a text file named “F9P Base config C99.txt. 

# Config changes format version 1.0 
# created by u-center version 18.11 at 11:37:53 on Tuesday, 08 Jan 2019 
[del] 
[set] 
  RAM CFG-UART1INPROT-NMEA 0        # write value 0                  to item id 10730002  
Flash CFG-UART1INPROT-NMEA 0        # write value 0                  to item id 10730002  
  RAM CFG-UART1INPROT-RTCM3X 0      # write value 0                  to item id 10730004  
Flash CFG-UART1INPROT-RTCM3X 0      # write value 0                  to item id 10730004  
  RAM CFG-UART1OUTPROT-UBX 0        # write value 0                  to item id 10740001  
Flash CFG-UART1OUTPROT-UBX 0        # write value 0                  to item id 10740001  
  RAM CFG-UART1OUTPROT-NMEA 0       # write value 0                  to item id 10740002  
Flash CFG-UART1OUTPROT-NMEA 0       # write value 0                  to item id 10740002  
  RAM CFG-UART1OUTPROT-RTCM3X 1     # write value 1                  to item id 10740004  
Flash CFG-UART1OUTPROT-RTCM3X 1     # write value 1                  to item id 10740004  
Flash CFG-UART1INPROT-UBX  0        # write value 0                  to item id 10730001  
  RAM CFG-UART1INPROT-UBX  0        # write value 0                  to item id 10730001  
  RAM CFG-MSGOUT-RTCM_3X_TYPE1005_UART1 0x1  # write value 1  0x1   to item id 209102be   
Flash CFG-MSGOUT-RTCM_3X_TYPE1005_UART1 0x1  # write value 1  0x1   to item id 209102be  
  RAM CFG-MSGOUT-RTCM_3X_TYPE1074_UART1 0x1  # write value 1  0x1   to item id 2091035f  
Flash CFG-MSGOUT-RTCM_3X_TYPE1074_UART1 0x1  # write value 1  0x1   to item id 2091035f  
  RAM CFG-MSGOUT-RTCM_3X_TYPE1084_UART1 0x1  # write value 1  0x1   to item id 20910364  
Flash CFG-MSGOUT-RTCM_3X_TYPE1084_UART1 0x1  # write value 1  0x1   to item id 20910364  
  RAM CFG-MSGOUT-RTCM_3X_TYPE1124_UART1 0x1  # write value 1  0x1   to item id 2091036e  
Flash CFG-MSGOUT-RTCM_3X_TYPE1124_UART1 0x1  # write value 1  0x1   to item id 2091036e  
  RAM CFG-MSGOUT-RTCM_3X_TYPE1230_UART1 0x5  # write value 5  0x5   to item id 20910304  
Flash CFG-MSGOUT-RTCM_3X_TYPE1230_UART1 0x5  # write value 5  0x5   to item id 20910304  
  RAM CFG-MSGOUT-RTCM_3X_TYPE1005_USB 0x1    # write value 1  0x1   to item id 209102c0  
Flash CFG-MSGOUT-RTCM_3X_TYPE1005_USB 0x1    # write value 1  0x1   to item id 209102c0  
  RAM CFG-MSGOUT-RTCM_3X_TYPE1074_USB 0x1    # write value 1  0x1   to item id 20910361  
Flash CFG-MSGOUT-RTCM_3X_TYPE1074_USB 0x1    # write value 1  0x1   to item id 20910361  
  RAM CFG-MSGOUT-RTCM_3X_TYPE1084_USB 0x1    # write value 1  0x1   to item id 20910366  
Flash CFG-MSGOUT-RTCM_3X_TYPE1084_USB 0x1    # write value 1  0x1   to item id 20910366  
  RAM CFG-MSGOUT-RTCM_3X_TYPE1124_USB 0x1    # write value 1  0x1   to item id 20910370  
Flash CFG-MSGOUT-RTCM_3X_TYPE1124_USB 0x1    # write value 1  0x1   to item id 20910370  
  RAM CFG-MSGOUT-RTCM_3X_TYPE1230_USB 0x5    # write value 5  0x5   to item id 20910306  
Flash CFG-MSGOUT-RTCM_3X_TYPE1230_USB 0x5    # write value 5  0x5   to item id 20910306  
RAM CFG-MSGOUT-RTCM_3X_TYPE1094_UART1 0x1    # write value 1  0x1   to item id 20910369  
Flash CFG-MSGOUT-RTCM_3X_TYPE1094_UART1 0x1  # write value 1  0x1   to item id 20910369  
  RAM CFG-MSGOUT-RTCM_3X_TYPE1094_USB 0x1    # write value 1  0x1   to item id 2091036b  
Flash CFG-MSGOUT-RTCM_3X_TYPE1094_USB 0x1    # write value 1  0x1   to item id 2091036b  
  RAM CFG-MSGOUT-UBX_NAV_PVT_USB 0x1         # write value 1  0x1    to item id 20910009  
Flash CFG-MSGOUT-UBX_NAV_PVT_USB 0x1         # write value 1  0x1    to item id 20910009  
  RAM CFG-MSGOUT-UBX_NAV_SVIN_USB 0x1        # write value 1  0x1    to item id 2091008b  
Flash CFG-MSGOUT-UBX_NAV_SVIN_USB 0x1        # write value 1  0x1    to item id 2091008b  
Flash CFG-UART1-BAUDRATE   0x70800     # write value 460800  0x70800 to item id 40520001  
  RAM CFG-UART1-BAUDRATE   0x70800     # write value 460800  0x70800 to item id 40520001  
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G F9P Rover config C99.txt 
Copy all the text below this line into a text file named “F9P Rover config C99.txt. 

# Config changes format version 1.0 
# created by u-center version 18.11 at 11:16:51 on Tuesday, 27 Nov 2018 
[del] 
[set] 
  RAM CFG-UART1INPROT-UBX  1        # write value 1                  to item id 10730001  
Flash CFG-UART1INPROT-UBX  1        # write value 1                  to item id 10730001  
  RAM CFG-UART1INPROT-NMEA 0        # write value 0                  to item id 10730002  
Flash CFG-UART1INPROT-NMEA 0        # write value 0                  to item id 10730002  
  RAM CFG-UART1INPROT-RTCM3X 1      # write value 1                  to item id 10730004  
Flash CFG-UART1INPROT-RTCM3X 1      # write value 1                  to item id 10730004  
  RAM CFG-UART1OUTPROT-UBX 1        # write value 1                  to item id 10740001  
Flash CFG-UART1OUTPROT-UBX 1        # write value 1                  to item id 10740001  
  RAM CFG-UART1OUTPROT-NMEA 1       # write value 1                  to item id 10740002  
Flash CFG-UART1OUTPROT-NMEA 1       # write value 1                  to item id 10740002  
  RAM CFG-UART1OUTPROT-RTCM3X 0     # write value 0                  to item id 10740004  
Flash CFG-UART1OUTPROT-RTCM3X 0     # write value 0                  to item id 10740004  
  RAM CFG-USBINPROT-UBX    1        # write value 1                  to item id 10770001  
Flash CFG-USBINPROT-UBX    1        # write value 1                  to item id 10770001  
  RAM CFG-USBINPROT-NMEA   1        # write value 1                  to item id 10770002  
Flash CFG-USBINPROT-NMEA   1        # write value 1                  to item id 10770002  
  RAM CFG-USBINPROT-RTCM3X 1        # write value 1                  to item id 10770004  
Flash CFG-USBINPROT-RTCM3X 1        # write value 1                  to item id 10770004  
  RAM CFG-USBOUTPROT-UBX   1        # write value 1                  to item id 10780001  
Flash CFG-USBOUTPROT-UBX   1        # write value 1                  to item id 10780001  
Flash CFG-USBOUTPROT-NMEA  1        # write value 1                  to item id 10780002  
  RAM CFG-USBOUTPROT-RTCM3X 0       # write value 0                  to item id 10780004  
Flash CFG-USBOUTPROT-RTCM3X 0       # write value 0                  to item id 10780004  
Flash CFG-UART1-BAUDRATE   0x70800  # write value 460800  0x70800    to item id 40520001  
  RAM CFG-UART1-BAUDRATE   0x70800  # write value 460800  0x70800    to item id 40520001  
 

H C099-F9P antenna specification 
H.1 Wi-Fi/Bluetooth antenna specification 
EX-IT WLAN RPSMA / Ex-IT WLAN SMA 

Manufacturer ProAnt  

 

 

 
 

 

Type ½ wave dipole dual-band antenna 

Polarization Vertical 

Gain +3 dBi 

Impedance 50 Ω 

Size 107 mm (straight) 

Type Monopole 

Connector Reverse polarity SMA plug (inner thread and pin receptacle) 
SMA plug (inner thread and pin) 

Comment To be mounted on the U.FL to SMA or reverse polarity SMA adapter cable 

Approval FCC, IC, RED, MIC, NCC, KCC*, ANATEL, and ICASA 

Table 3: Wi-Fi/Bluetooth antenna 

☞ The variant included in the C099-F9P kit is with SMA connector and has to be mounted on the 
corresponding antenna connector of the C099-F9P board if you wish to use Wi-Fi or Bluetooth 
connectivity. 
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I Mechanical board dimensions 

 
Figure 56: C099-F9P rev. E dimensions 

J C099-F9P schematics 
The following pages show the complete schematic for the C099-F9P evaluation board. 
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Related documents 
[1] ZED-F9P Interface description, doc. no. UBX-18010854 
[2] ZED-F9P Integration manual, doc no. UBX-18010802 
[3] u-center User guide, doc. no. UBX-13005250 
[4] u-blox GNSS Sensor and VCP Device Driver User guide, doc. no. UBX-15022397 
[5] u-blox Short Range Modules AT Commands Manual, doc no. UBX-14044127 
[6] s-center: https://www.u-blox.com/en/product/s-center 
[7] ANN-MB series multi-band GNSS antennas Data sheet, doc.no. UBX-18049862 

☞ For regular updates to u-blox documentation and to receive product change notifications, register 
on our homepage (www.u-blox.com). 

 

Revision history 
Revision Date Name Comments 

R01 10-Jul-2018 ghun/byou Initial release. 

R02 19-Oct-2018 byou Updates for the C099-F9P rev. B board revision. 

R03 09-Jan-2019 olep Updates for FW upload procedure for ODIN-W2. 

R04 21-Feb-2019 olep Updated Arduino J9 schematics. Polarity requirement of the battery 
connector. 

R05 25-Sep-2019 jhak/jjus Updates for the C099-F9P rev. C board revision. 

R06 07-Nov-2019 jhak Updates for the C099-F9P rev. E board revision. 

Connectivity SW renamed u-connectXpress. 

R07 05-Dec-2019 mala Improved the quality of the schematics drawings. 

R08 09-Apr-2020 jhak/mala Added a missing step about selecting EVK-ODIN-W2 via ST-LINK in section 
“u-connectXpress software”. 

R09 29-June-2020      ghun Update for HPG 1.13 

  

https://www.u-blox.com/en/product/s-center
http://www.u-blox.com/
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Contact 
For complete contact information, visit us at www.u-blox.com. 

u-blox Offices     

North, Central and South America 

u-blox America, Inc. 

Phone: +1 703 483 3180 
E-mail: info_us@u-blox.com 

Regional Office West Coast: 

Phone: +1 408 573 3640 
E-mail: info_us@u-blox.com 

Technical Support: 

Phone: +1 703 483 3185 
E-mail: support@u-blox.com 

 Headquarters 
Europe, Middle East, Africa 

u-blox AG  

Phone: +41 44 722 74 44 
E-mail: info@u-blox.com  
Support: support@u-blox.com 

 Asia, Australia, Pacific 

u-blox Singapore Pte. Ltd. 

Phone:  +65 6734 3811 
E-mail:  info_ap@u-blox.com 
Support: support_ap@u-blox.com 

Regional Office Australia: 

Phone:  +61 2 8448 2016 
E-mail:  info_anz@u-blox.com 
Support: support_ap@u-blox.com 

Regional Office China (Beijing): 

Phone: +86 10 68 133 545 
E-mail: info_cn@u-blox.com  
Support: support_cn@u-blox.com 

Regional Office China (Chongqing): 

Phone: +86 23 6815 1588 
E-mail: info_cn@u-blox.com  
Support: support_cn@u-blox.com 

Regional Office China (Shanghai): 

Phone: +86 21 6090 4832 
E-mail: info_cn@u-blox.com  
Support: support_cn@u-blox.com 

Regional Office China (Shenzhen): 

Phone: +86 755 8627 1083 
E-mail: info_cn@u-blox.com  
Support: support_cn@u-blox.com 

Regional Office India: 

Phone: +91 80 405 092 00 
E-mail: info_in@u-blox.com 
Support: support_in@u-blox.com 

Regional Office Japan (Osaka): 

Phone: +81 6 6941 3660 
E-mail: info_jp@u-blox.com 
Support: support_jp@u-blox.com 

Regional Office Japan (Tokyo): 

Phone: +81 3 5775 3850 
E-mail: info_jp@u-blox.com 
Support: support_jp@u-blox.com 

Regional Office Korea: 

Phone: +82 2 542 0861 
E-mail: info_kr@u-blox.com 
Support: support_kr@u-blox.com 

Regional Office Taiwan: 

Phone: +886 2 2657 1090 
E-mail: info_tw@u-blox.com  
Support: support_tw@u-blox.com 
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